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1  Assigned Activities 
 

This section was initially written by Paul Smith, with updates by Christoph Borst, to log main assigned 

activities and follow‐up suggestions.  

 

Tools used 

Unity (Game Engine) 

Autodesk Maya (3D modeler) 

Unity SteamVR plugin 

VRTK (Unity asset pack, VR toolkit) 

Trello (web‐based project management tool) 

 

UL Overview 

The assistants from CMIX at the University of Louisiana at Lafayette mentored students during regular 

visits. This also included the following assignments (more detail provided later): 

 

A1 Basic Maya modeling tutorial  

 

We assigned the students a series of online videos to watch so that they could learn the basics of 3D 

modeling with Maya. Main suggestions for revision: 1) Find a simpler modeling tool for beginners. The 

students did not need advanced features, and 2) We believe that better videos could be found, to make 

sure the illustrated techniques consider best practices for game engines (some of these are hinted by 

Adam Prejean’s notes). 

 

A2 Students model and import their own environments 

 

We asked the students to use their own ideas and make models for the VR games they were trying to 

create. Main suggestions for revision: We recommend splitting this assignment up into parts, seen as 

phase 2‐4 in the suggested curriculum document. 

 

A3 Adding VR 

 

We showed the students how to add VR camera rigs into their Unity scenes, for viewing with head‐

mounted displays (they used Oculus Rift CV1 displays). 

 

DTSMA Overview 

David Thibodaux STEM Magnet Academy personnel provided some background assignments to get 

students started prior to the more frequent visits from UL Lafayette personnel. Other information is in a 

separate Mozilla‐funded project “Tiny House VR Project”, due to some overlap of topics. Some of these 

assignments were not completed, or were reworked into the activities above. 

 



 

Aug 17: Roll‐a‐Ball  

 

This is a standard tutorial, from Unity, for beginning with Unity. It is important for introducing basic 

operation of Unity. 

 

Aug 17: Space Shooter 

 

This is another standard tutorial, from Unity, for beginning with Unity. Scripting aspects may be too 

much for some students, as not all students had programmed before. Scripting vs. Modeling should be 

emphasized depending on student backgrounds. Beginner Unity tutorials do not teach modeling, 

beyond adding simple primitives. 

 

Aug 23: Candy Crush self‐study 

 

UL Lafayette personnel were not involved in this assignment. Refer to the “Tiny House VR Project”. 

 

Sep 3: Critical thinking in game design 

 

UL Lafayette personnel were not involved in this assignment. Refer to the “Tiny House VR Project”. 

 

Sep 7: Importing assets 

 

Students were asked to create a new Unity project, import any reasonable assets into it, and add a 

standard Unity object (sphere) to the scene. 

 

Sep 13: Video games report 

 

Students were asked to write a 1000‐word report describing a game play experience or that of someone 

else, after having a pair meeting in which one student taught another student how to play an unfamiliar 

game. The report included aspects such as describing the most and least difficult game play aspects. 

 

Sep 21: Maya tutorials 

 

This started as an assignment to model a church based on a Maya 2014 tutorial. It was incomplete, 

reworked into UL A1. 

 

Sep 30: Unity Scope and Sequence Unit 3: Game Design Theory 

 

Students were asked to start developing a game design document based on MIT OpenCourseWare 

“CMS.300/CMS.841, Introduction to Game Studies, Fall 2011: Game Analysis Guidelines”. The general 

idea has been considered in “phase 2” in an attached curriculum outline. 



 

 

Oct 8: 3D environment development 

 

This assignment was intended to have students develop a 3D environment for an educational 

application of their choice. Due to the complexity of working in Maya and Unity for beginners, this 

assignment was not readily completed, and was instead reworked into the UL A2 assignment and guided 

by several mentoring visits. 

 

Nov 13: Maya “quiz” 

 

Students were asked to present their 3D environment pictorially and by filling in a blank chart that asked 

“what do we know”, “what questions do we have”, “what did we learn”, and “what would you do next”. 

 

Nov 15: Avatars 

 

Students were assigned to create 3D avatars to display in their environments. Human‐like avatars can be 

very complex to both model and use, therefore we do not recommend them unless good pre‐made 

assets are incorporated. The assignment allowed students to use simple avatars such as a block or a 

stick person. The assignment was somewhat open‐ended and we believe a more constrained and 

specific assignment is necessary, if any, on avatars. 

 

 

 

 

   



A1 Maya Basics/Unity Importing Tutorial 

 

Draft by Paul Smith 

 

Introduction 

 

This tutorial is meant as a stepping stone to get you familiar with some of Maya's more useful functions 

and to with importing your Maya creations into Unity. 

 

Objectives 

The objective of this assignment is to have you move some environment into Unity so that you can view 

something you have created in VR. 

 

Details 

Follow this link to a Youtube playlist I have compiled that will lead you through the entire process 

(https://www.youtube.com/playlist?list=PLXbKOvGhY7j8t7hJpgG73I0MqK2xZA‐0‐). Bonus points will be 

available to students that add extra elements. After the due date, I will bring an Oculus Rift and a VR PC 

to the class to let you view your projects in VR if and only if your project is complete by the due date. 

{additional videos can be found in the original playlist: 

https://www.youtube.com/playlist?list=PLsPHRLf6UN4n778LjMnKVG1nw_PX8Lhja} 

 

Submission Requirements 

•  At least 3 screenshots of the complete project in Unity 

•  A minimum 100 word description of the work that you did 

•  A link to a zipped folder containing your Unity and Maya projects uploaded to Google Drive. 

 

This is an individual assignment (to be worked on your own). All of these things can be submitted as 

comments on the card in Trello, as well as however else Ms. Darjean requires you to submit them for 

your grade. Your reports will be checked for similarities to prevent copying. This assignment is due 

Saturday, December 9 at 11:55 PM. Late submissions will not be considered for VR integration. 

   



A2 Environments 

 

Draft by Adam Prejean / Paul Smith 

 

Static Environments should be completed and ready for VR implementation by the time we get back 

from Christmas break. 

We will make a list of what is left to be done and add to this Trello card. 

We will discuss in more detail tomorrow. 

Summary of advice given in class 

 

Modeling 

•  Don't use backface methods in Maya when exporting to Unity 

•  Make walls have a thickness using Edit Mesh > Extrude 

•  If faces will always be hidden, they can be deleted (no point in wasting resources) 

•  Avoid Polygons with more than 4 points (top and bottom of this mesh) 

•  Quick way to fix this is to select the mesh and use Mesh > Triangulate 

 

UVs 

•  Create UVs with matching density 

•  Use texture I provided 

•  Easiest way to do this is to use Automatic Mapping, then Stitch Together on any edges necessary 

 

Materials 

•  Make simple Lambert materials in Maya and apply to models. 

•  I like to name materials with a prefix + asset name (ie, "M_Wall") 

•  See this for more info on naming conventions 

(https://wiki.unrealengine.com/Assets_Naming_Convention#Assets_names) 

•  These materials should import into Unity as the "Standard Shader" and already be applied to the 

models. 

•  This isn't necessary, but can save some time. 

 

Exporting 

Export as FBX using File > Game Exporter 

Model Default 

FBX Version 2014/2015 

Only export Geometry, Locators, Joints that will be used in Unity. 

 

Remember to: 

•  Create UVs 

•  Freeze Transforms 

•  Delete History 



A3 VR Integration 

 

Draft by Paul Smith 

 

It’s finally time to add VR to your environments! In this assignment, we add a tool called VRTK to your 

Unity scenes, and then use it to view your scenes in VR. 

 

Objectives 

The objective of this assignment is to get you familiar with working with VR rigs and to observe your 

models in VR. 

 

Details 

This assignment is broken into two parts: 

 

Part 1 (on your own) 

First, import VRTK from the asset store into Unity. Then, follow this link 

(https://www.youtube.com/watch?v=bxxGaJg75g4) to view a video about how to set up the VR 

simulator in VRTK. This will allow you to view your scene without the need of a headset. 

 

Part 2 (after class on 1/25/18) 

Import SteamVR from the asset store into your project. I will work with you to get the SteamVR camera 

rig added to your main VRTK rig. This will allow you to use VR headsets (Oculus, Vive, Windows MR) to 

view your scene. I will bring an Oculus Rift for testing purposes and so you can see your environments. If 

you want to get familiar with the process, you can follow this link (https://youtu.be/tyFV9oBReqg) to 

find out how to do this. 

 

Bonus 

If you add at least one other feature of VRTK to your Unity scene, you can earn bonus point for this 

assignment 

 

Submission Requirements 

One screenshot of your Unity scene with a clear view of the hierarchy. 

A minimum 50 word write‐up on what you did in this assignment, what challenges you faced (if any), 

and what you did to overcome them (if any). 

A link to a zipped folder containing your Unity project folder uploaded to google drive. 

This is an individual assignment (to be worked on your own). All of these things can be submitted as 

comments on the card in Trello, as well as however else Ms. Darjean requires you to submit them for 

your grade. Your reports will be checked for similarities to prevent copying. This assignment is due 

1/25/18. Late submissions cannot receive bonus credit. 

 



2  An Introductory VR Course Sketch 
 

This section is Paul Smith’s high‐level sketch of what a VR curriculum may look like, based on his 

reflection on the mentoring experience. Minor editing was done by Christoph Borst. 

 

Goals 

The goal of this curriculum is to help you to develop a course around the topics of 3D modeling, (use of) 

game engines, creating Virtual Reality applications, and (optionally) creating networked applications 

within game engines.  

 

Skills 

Your students will acquire skills in 3D modeling, organization and planning of large‐scale projects, use of 

software relevant to digital entertainment industries, and scripting (programming). 

 

Actions 

Your students will create 3D models, lay them out in a scene in a game engine, and add interactive 

components to their scene (VR and networking). 

 

Deliverables 

Your students will each create two scenes in a game engine. The first will be a pre‐planned scene where 

every student will be making the same thing. The second will be a student designed scene. Both of these 

scenes will be populated with 3D models. 

 

Tools and Programs 

There are two major types of programs that you will need for this curriculum: a game engine and 3D 

modeling software. Additionally, students should learn to use some project management tool (such as 

Trello) to plan and report progress throughout. Two of the most common game engines used in 

education are Unity and Unreal Engine. Major 3D modeling applications include Autodesk Maya, 

Autodesk 3DSMax, and Blender, and all are available free for educational purposes. But, we recommend 

considering simpler modeling tools depending on the intended course duration and difficulty. 

    

Suggested Phases 

 

1. Standard 3D Modeling  

2. Planning Environments 

3. Creating Models and Textures 

4. Layout in Game Engine 

5. Adding Virtual Reality  

6. (Optional) Adding Networking 

   



Phase 1: Standard 3D Modeling  
 

Goals 

 

The goal of this phase is to allow students to learn the basics of 3D modeling, or to refresh them if they 

have prior experience. The reason this assignment is standardized is twofold: so that the students can 

have a pre‐planned and pre‐explored baseline, and so that grading should be easier as you (the 

instructor) only need to compare the student’s work to the basis that you are using to teach from. 

 

Skills  

 

By the end of this phase, students will have developed all of the basic skills necessary to succeed in their 

individual projects from a modeling and texturing standpoint. 

 

Actions 

 

Students should follow a set of tutorials based on the specific 3D modeling software you choose to use. 

For example, Maya includes introductory tutorial videos. Be mindful that not all tutorials are intended 

for modeling for a game engine, and some practices in tutorials may conflict with the best practices for 

game development (Adam Prejean’s notes include some comments on problems encountered). We 

strongly recommend that students start modeling in terms of some real‐world unit (e.g., meters) 

according to how they want their models to appear in VR. 

 

Deliverables 

 

Students should turn in a scene with the products of their modeling assignments contained within. 

Optionally, it is helpful for the students to turn in a document stating what was done, what challenges 

were faced, and how they were overcome. This is a generally good project management skill that will 

translate well to their future jobs. 

 

Tools and Programs 

 

This section will make use of your 3D modeling software and can also introduce project management 

software for documenting progress. 

   



Phase 2: Planning Environments 
 

Goals 

 

The goal of this phase is to help your students create a plan of attack for their projects. Students may 

have lofty ambitions that cannot be realized by the end of the project period. But by careful planning of 

their environments, students will have a better idea of exactly what they are making and how long it will 

take before they begin working on it. It will also allow the students to have a tangible blueprint of how 

the environment will look and what pieces will compose it. 

 

Skills 

 

By the end of this phase, students will have gained skills and experience with project planning. They will 

have learned how to critically analyze things like feasibility of a project within time constraints and 

prioritizing tasks. 

  

Actions 

 

Have the students plan out their environments. Have them make a couple of first person perspective 

drawings of their proposed environment as well as a top‐down view. Additional details are encouraged. 

Have the students think through the storyboard and the pieces they need to add to make their 

environment look and behave as they want (objects and behaviors). Have them develop a plan that 

breaks everything down into tasks or deliverable pieces, with estimated time frame (due dates per 

piece), listed on a project management tool (such as an online “scrum board” tool). Have them prioritize 

critical pieces first. They may need to adjust this list throughout the project due to a variety of 

circumstances. Review the students tasks and progress with them periodically and discuss any 

adjustments needed. 

 

Deliverables 

 

Students should turn in their concept drawings, as well as their task breakdown (what do they feel like 

they should accomplish by X date, by Y date, etc). Have them set milestones for themselves.  

 

Tools and Programs 

 

This section could make use of digital art programs, such as Photoshop or GIMP, but these are not 

necessary. Hand drawing should do just fine. Also, some project management software should be used.  

 

   



Phase 3: Creating Models and Textures 
 

Goals 

 

The goal of this phase is to allow students to create the building blocks that will make up their custom 

scenes. We generally expect students to create their own models instead of using others work. This 

section also emphasizes how to adapt the students plans from something that works in 2D into 

something that looks appropriate for 3D. 

 

Skills  

 

By the end of this phase, students will have experience modeling a variety of 3D objects as well as more 

familiarity with the workflows of modeling program used. Student will also have to manage their 

growing project with a project management tool to adapt their plans to meet goals. 

 

Actions 

 

Have students model and texture their assets using the skills they developed in Phase 1. They should 

roughly follow their tasks that they created in Phase 2. Some adaptation will be required, but the 

students should come out with all of the necessary parts to make their scenes work. 

 

Deliverables 

 

Students should turn in all of the 3D models that they laid out in their planning phase. Optionally, have 

the students report on some difficulties that they had either with their project planning or with the 

modeling itself. Pay attention to the designs themselves to make sure students are not getting them 

from online sources without permission. 

 

Tools and Programs 

 

This section will make use of your 3D modeling software and your project planning software. 

 

   



Phase 4: Layout in Game Engine 
 

Goals 

 

The goal of this phase is to allow students to use all of the components that they created. They will also 

specify how the user will interact with those components to create a cohesive environment. Most game 

engines will contain a physics and/or collision detection system to control the way objects interact with 

one another. The student will need to work with these systems to create the behaviors they want. 

 

Skills  

 

By the end of this phase, your students will have experience working with a game engine to create 

scenes and environments, a crucial part of the game making process. They will also learn how the 

workflow pipeline of a game is handled (exporting 3D models and importing them into a game engine). 

 

Actions 

 

Students will first have to try some game engine intro tutorial(s). This could optionally be moved to 

Phase 1 or into an additional phase. Once they have a basic idea of how to get started with the game 

engine, have students export all of their 3D components from the modeling software and import them 

into the game engine. Then the students can begin arranging the models to create a scene. There may 

be a need to resize some object to better fit the scale of the environment, although it is best for 

students to always think in real‐world units for VR (e.g., one “Unity unit” meaning “one meter”). They 

should also start developing basic interactions such as control of a moving object based on input, or 

interactions between objects. Note, however, that standard keyboard or joystick controls for moving the 

main player are not a preferred way to move in VR, as they are often not natural and can even lead to 

motion sickness (if visuals don’t match real user motion). 

 

Deliverables 

 

Students should turn a copy of their game project folder along with a description of the work they did, 

what challenges they faced, and how they overcame them. 

 

Tools and Programs 

 

This section will make use of your game engine, your 3D modeling software, and your project planning 

software. 

   



Phase 5: Add VR Components 
 

Goals 

 

The goal of this phase is to show students how to work with VR systems within their scenes to make 

them more life‐like, immersive, and interactive. Students will need to adapt their environments so that 

they are suitable for viewing in VR. They will also need to add all of the necessary scripts and objects 

that allow VR Rigs to function in their scenes.  

 

Skills  

 

By the end of this phase, your student will learn how to use and manipulate VR Software Development 

Kits (SDKs) to suit the needs of their projects. They may also learn how to handle a small amount of 

related scripting in a game engine environment setting. In addition, they will become more familiar with 

the game engine software itself. 

 

Actions 

 

Have students download the appropriate VR SDKs for the environment they are using. Take into 

consideration both the kind of hardware being used and also the game engine. For example, if you plan 

to use the HTC Vive hardware with the Unity game engine, you would download the SteamVR Unity 

plugin from the Unity Asset Store. Once these have been downloaded, have the students use the scripts 

provided to create VR camera rig objects. These allow you to view your environment through a VR 

headset. For more complex interactions, such as grabbing and pick up objects or moving through the 

environment (via teleportation or other means) other toolkits or scripting will be necessary (such as the 

VRTK toolkit for Unity). Most of these toolkits come with beginner tutorials. 

 

Deliverables 

 

Students should turn a copy of their game project folder along with a description of the work they did, 

what challenges they faced, and how they overcame them. 

 

Tools and Programs 

 

This section will make use of your game engine, your project planning software, and any external 

toolkits you decide to use. 

   



Phase 6: (Optional) Add Networking Components 
 

Goals 

 

The goal of this phase is to show students how to work with networking systems in their scenes so they 

can share their environments with others. This is an advanced topic so we only concentrate on basic 

networking capabilities built into the game engine. Other custom networked functionality can be added 

through scripting. 

 

Skills  

 

By the end of this phase, your students will have learned how work with networking toolkits or 

implement their own network code within the confines of a game engine. Depending on which route 

you take, they may also have gained substantial scripting experience. 

 

Actions 

 

Have students either follow appropriate networking tutorials for your chosen game engine or download 

a prebuilt networking SDK (for example, for Unity, see its UNetSetUp manual). These tutorials do not 

necessarily need to be specific to VR networking, as most of the general concepts apply regardless. For 

vocal communication, it is recommended that you run a separate software alongside the executable 

build of your game project (e.g., TeamSpeak). A basic networking assignment would be to let students 

see some representation of each others’ heads (even if just blocks) in VR. This can be extended to other 

tracked real‐world objects (hand‐held controllers) or to actions of game objects. 

 

Deliverables 

 

Students should turn a copy of their game project folder along with a description of the work they did, 

what challenges they faced, and how they overcame them. 

 

Tools and Programs 

 

This section will make use of your game engine, your project planning software, and any external 

toolkits you decide to use. 

   



3  Adam Prejean’s Notes 
These notes were made by Adam Prejean to document his main activity and some specific 
comments he provided to students during visits from UL Lafayette to DTSMA. 
 
Adam Prejean 
Computer Graphics Artist 
University of Louisiana at Lafayette 

Main Tasks: 

• Regularly visited DTSMA as needed to assist students. 
• Compiled list of resources to get students acquainted with Autodesk Maya. 
• Lead students in successful creation of 3D assets. 
• Assessed students' progress on tasks/goals and provided feedback to students both during 

visits and via Trello. 

Information Shared: 

Tutorials: 

• General overview of Autodesk Maya - link 
https://www.youtube.com/playlist?list=PLxVq-O_gWqkDnwvdsyRZTr-6iDwjPlTKX 

• UV mapping basics - link 
https://www.youtube.com/watch?v=G2qFdVr-FEk 

• UV editing tools - link 
https://www.youtube.com/watch?v=6f2-CZHp-_M&feature=youtu.be 

• UV mapping tips - link 
http://www.paulhpaulino.com/6-tips-to-improve-your-uv-mapping-workflow/ 

• Various Autodesk Maya tutorials - link 
https://www.youtube.com/playlist?list=PLyMuCmXTUZG5ve080KgYhT6nojrlJkV25 

Files: 

These files are available through our same blog that distributes this document (see Forward). 
• ProjectName.zip - Sample directory structure to show students how their projects can be 

organized in a production environment. 
• Inch_Grid_Overlay_UVmapping.png - Image that can be used as a texture to check the 

UV layout of a 3D model. 
• Maya_Hotkeys.doc - Document for students to use as a quick reference when working in 

Autodesk Maya. 
 



Static Environments - Assignment 

• Students were given the assignment to create all of the 3D assets that would be used to 
create their individual VR environments. 

• We asked that their environments be completed and ready for VR implementation by the 
time everyone was back from Christmas break. 

• This assignment was also an opportunity to see how well students would work on a task 
outside of the classroom. 

Main Student Tasks for Assignment: 

Students were required to adhere to the following guidelines while working on their assignment. 

Modeling 

• Don't use backface methods in Maya when exporting to Unity 
• Make walls have a thickness using Edit Mesh > Extrude 
• If faces will always be hidden, they can be deleted (no point in wasting resources) 
• Avoid Polygons with more than 4 points (top and bottom of this mesh) 

• Quick way to fix this is to select the mesh and use Mesh > Triangulate 

UVs 

• Create UVs with matching density 
• Use texture I provided 

• Easiest way to do this is to use Automatic Mapping, then Stitch Together on any edges 
necessary 

• Start with simple mapping 
• Right-click "Shaded" button in UV Editor to show UV shells in viewport. 
• Use 3D Cut and Sew tool to create new shells. 
• Unfold (and sometimes Optimize) to smooth results. 
• Layout 

Materials 

• Make simple Lambert materials in Maya and apply to models. 
• I like to name materials with a prefix + asset name (ie, "M_Wall") 

• See this for more info on naming conventions 
https://wiki.unrealengine.com/Assets_Naming_Convention#Assets_names 

• These materials should import into Unity as the "Standard Shader" and already be applied to 
the models. 

• This isn't necessary, but can save some time. 
  



Exporting 

• Export as FBX using File > Game Exporter 
• Model Default 
• FBX Version 2014/2015 

• Only export Geometry, Locators, Joints that will be used in Unity. 
• Remember to: 

• Create UVs 
• Freeze Transforms 
• Delete History 

Notes from in-person DTSMA Visits: 

11/16/2017 

• Instructed teacher and students on how to use Trello for project management and tracking. 
• Assisted teacher by creating a Trello board for each student's project. 
• Teacher decided we can use Trello to give feedback and answer student questions.  

• Students were told to send questions, comments, and updates on a regular schedule 
and post project descriptions and design documents to Trello. 

• Students seem to be grasping Maya, but mainly need guidance with best practices when 
creating assets for a game environment. 

• Assisted student with their project, explained how to better optimize the 3D model for Unity. 
• Explained modular asset creation and why it's better to arrange assets inside of Unity rather 

than trying to create everything in a single Maya scene. 
 

11/30/2017 

• Students are taking more time than anticipated. 
• Most students seem to be grasping Maya, but are trying to do too much in the given 

timeline. 
• Reviewed student work, explained how models and textures could be better optimized for 

Unity. 
• Reiterated that students should use Trello to send updates, questions, etc. on a regular 

schedule. 
• Some students were experiencing navigation issues in Maya, but said they weren't running 

into those problems on their home systems. 
• This may have been a GPU issue.  I emailed a possible solution to teacher.  

 

12/14/2017 

• Discussed Static Environment Assignment in more detail. 



• Reviewed student work, provided specific feedback on their progress and suggested next 
steps. 

• Provided more information on best practices for asset creation, including Modeling, UVs, 
Materials, and Exporting. 

 

01/11/2018 

• Reviewed student progress and suggested next steps. 

01/23/2018 

• Reviewed student progress and suggested next steps. 
• Provided more information on best practices for asset creation, including Modeling and 

Exporting. 
• Walked through how best to deal with scaling differences between Maya and Unity when 

exporting assets. 
• Some students noticed an issue with the scale of their 3D models in Unity. 

• Helped student import a 3D CAD model (robot) and explained what needed to be done to 
the model to prepare it for Unity. 

 

01/30/2018 

• Helped import student's 3D model from CAD software into Maya to be exported correctly for 
Unity.   

• Instructed student to prepare model for export and import it into their Unity project. 
 

02/20/2018 

• Assisted with camera animation in Unity for video captures of student projects. 
• We were able to get better results than before, but still not completely what was desired. 

• The 3rd party plugin used was not easy to work with. 

Other Notes: 

11/14/2017 

• Some of the students are struggling with UVs and texturing. 

12/14/2017 

• Covered a variety of asset creation issues and how to correct them. 
• Don't export models with "Smooth Mesh Preview" 
• Explained why static objects should not be transformed in Maya.  



• Instructed students on how to make the walls for their environments using the Extrude 
function in Maya to give the walls thickness. 

• Explained modular asset creation and why it's better to arrange assets inside of Unity rather 
than trying to create everything in a single Maya scene. (Chairs, Tables, Laptops, etc.) 

01/09/2018 

• Covered more asset creation issues and how to correct them. 
• Explained how to clean up geometry by deleting unnecessary edges and merging 

vertices. 

01/10/2018 

• Reiterated best practices for organizing and exporting the 3D model. 
• Provided student with a Maya scene to use as a reference so they can see how to better 

optimize the stair geometry in the environment. 

01/16/2018 

• Reiterated how to assign materials in Maya. 

01/18/2018 

• Opened student's Maya scene to try exporting and testing in Unity.  
• Reiterated that only Geometry, Locators, and Joints that are needed in Unity should be 

exported using Maya's Game Exporter. 
• Showed an easy way to do this by selecting all objects needed, grouping them together, 

selecting the group, and using the "Export Selection" option. 

01/24/2018 

• Helped import student's 3D model from CAD software into Maya to be exported correctly for 
Unity. 

   



4  Paul Smith’s Notes 
 
These notes were made by Paul Smith to document his main activity during visits from UL 
Lafayette to DTSMA. 
  
[PAUL - UNITY] 10/26/2017: First day at DTSMA for mentoring/checking progress on students 
with Unity projects. Was a little difficult, as unity was not running on any of their machines and 
they had no Maya files (except for tiny house, but it was incomplete). The school is still having 
problems with some software called deep freeze that (presumably) resets the computer to some 
image when they get restarted. I discussed some of the projects with the students working on 
them. The group is working four separate projects. The one I knew about, the tiny house project, 
is meant for VR. Another project was a rolling ball demo that could shoot out pellets or pick 
them up, but it would conserve the mass of the player sphere while doing so. The third was to 
be a simulation of the robot arena for the school’s robotics competition. The remaining project 
was some sort of laboratory environment? There was also a fire drill halfway through the 
session. 
 
[PAUL-UNITY] 11/9/2017: First visit since Mozilla support has officially been announced. Saw 
an update of one student’s work (one could get Unity up and running on their laptop). Had a 
small town built with some low-poly models and had added the built-in unity first-person 
controller. Worldbuilding was nice. Everything was an easily topple-able rigidbody. Offered 
some advice on how to get controller input. One project goal was to demo at the B&N 
makerfaire. Students were waiting for some supplemental instruction for texturing in Maya. 
 
[PAUL-UNITY] 11/16/2017: Unity is now working on the school computers. Adam and I went 
over the basics of how to use Trello. We thought it best to create an individual board for each 
project that are all connected under one group. Many students did not have their models 
prepared ahead of time, so Adam used one students model to explain some texturing things 
and some modelling best practices. I encouraged the students to have broken their projects up 
into tasks by the time that we get to the school next week. I explained some of the ideas around 
project management and setting feasible goals. 
 
[PAUL-UNITY] 11/30/2017: Students are still working on projects in Maya, but limited progress 
since last visit. One group of students has taken advantage of the Trello tools\ that we showed 
before Thanksgiving break. One student (tiny house project) was making good progress with 
texturing.  
 
[PAUL-UNITY] 12/4/2017: Formally gave assignment 1 for the students to work on. I found 
some good Maya beginner tutorials and compiled them, along with some instructions on how to 
export from Maya into Unity. The submission should include screenshots of the environment 
that they created in Unity, as well as copies of both their Maya and Unity project folders. 
Hopefully this will give any students who are overwhelmed something that can ease them into 



their larger projects. Also, I plan to show them their environments in VR by taking the scenes 
they send me and adding a steam VR rig to them. 
 
[PAUL-UNITY] 12/14/2017: Last update before the students go on break. Adam and I layed out  
assignment 2 for the students to work on over the break. We intend for their modeling, texturing, 
and lighting to be done by the time they get back to school so we can start incorporating vr 
assets into their scenes. Adam spent much of the time going over specific questions the 
students had about their models. He also left various resources for the students to look over on 
the assignment page. We think this should be very doable for the students and are excited to 
see their finished Maya models. Happy holidays everyone! 
 
[PAUL-UNITY] 1/11/2018: Adam and I went to DTSMA to check up on the assignment that we 
issued in December. We were able to add a VR simulation program to a student’s scene 
successfully. This is one aspect I had been looking at over the break, trying to find ways to 
accommodate students, since some of their work happens at home and none of them have VR 
headsets yet. We are using a tool called VRTK for this simulation, as well as other interactive 
bits that the students may wish to add to their projects (if time allows). 
 
[PAUL-UNITY] 1/23/2018: Adam and I reviewed student projects. I introduced assignment 3 to 
add actual vr camera rigs to their scenes. The scenes are progressing nicely, much more 
complete than they were before the break. All students now have the simulation rig in their 
scenes as well.  
 
[PAUL-UNITY] 1/30/2018: Students now have VR integrated into their scenes! It was great 
getting to see the students reactions to view their environments in VR for the first time. Also, 
after some initial complications, we got a digital copy of the official First Robotics Competition 
field into Montana’s project. 
 
[PAUL-UNITY] 2/1/2018: Student computers and headsets finally came in at DTSMA! We spent 
most of our time unboxing their new workstations and going over best practices when working at 
a desk with VR equipment. Obtained a copy of the tiny house neighborhood scene to try loading 
into Kvasir. Resolved some problems with the First Robotics Competition project not zipping 
properly. 
 
[PAUL-UNITY] 2/8: We also made fly-through video of each of the student’s environments. 
 
[PAUL-UNITY] 2/15 & 2/18: Worked with students to load their models for a networked Kvasir-
VR demo. Tiny house is loaded but untested. Others should be much easier due to the use of 
actual geometry for the ground instead of terrain. We also polished fly-through videos of each of 
the student’s environments. 
 
(Nicholas Lipari and Jason Woodworth took over for remaining aspects, especially school-to-
school networking setup and demos. We also discussed a basic Unity networking assignment to 
let students create their own multi-user networked versions of their VR environments). 


